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Microsoft® Office Outlook® 2016

Outlook 2016 Home View

The default view opens to the Mail Folder, Navigation Pane, the Inbox, To-Do Bar, Reading Pane and the Ribbon.
The Home View provides easy access to your messages and collaboration activities.
Instant Search
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e A bbbt o
mazon Kingle Lirec...
—u Fx3 Amazon Indie Pyblishing M... Mon 1:03 PM Thanks -
. . /‘ -
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between the main Message List Sort and group Reading Pane Social To-Do Bar
views in Outlook. Displays email email items Read emails and  Connector Organize your
. messages, by clicking the see attachments Connects activities, tasks,
Click == for sender’s name, Arrangements  without opening  you to social ~ appointments, etc.,
Navigation Options. o hiect date, size, Header in the them in separate  and business  in an easy access
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The Ribbon

Send / Receive Folder View Q Tell me what you want to do...
[=7  [G:Ignore 5 5 5 S ¥ Inbox £ To Manager ¥ Move - 21 Unread/ Read o
E ﬁE 7 Clean Up ~ [ﬁ I&_plej' Eeﬁej Foﬁru_\r?ard . B E7 Team Email v Done ’ = Rules = H Categorize - EE Address Book St—ore
Email Items - s Junk - All <l More - = Reply & Delete ¥ Create New 7| Ok OneNote | Follow Up - Filter Email
Mew Delete Respond Quick Steps ] Move Tags Find Add-ins -
I I I I I I I
A B C D E F G
A - New: Mail Message (Ctrl+N), Task (Ctrl+Shift+K), E - Move: Move selected items to new folder, create Rules
Appointment (Ctrl+Shift+A), etc. to manage recipient(s) messages, access OneNote.
B - Delete: Delete (Ctrl+D), Ignore, Clean Up, Junk. F - Tags: Unread/Read (Ctrl+U+Q), Categorize, Follow Up.
C - Respond: Reply (Ctrl+R), Reply All (Ctrl+Shift+R), G - Find: Search for Contacts, access Address Book,
Forward (Ctrl+F), etc. Filter Email: Filter email messages in selected folder(s) to
D - Quick Steps (New): Automate common or repetitive tasks. only show certain items, such as Unread or Flagged items.

Note: The options available in the Ribbon will change according to the Outlook Item you are using. Page 1



Composing and Sending an Email Message

E1 E-mail Message
This section will show you how to open, compose and send an email message. S Appoi
Appointment
Opening a new email: =% Meeting
There are several ways to create a new email: Contact
* From the Expanded Ribbon choose New Email or New Items. Task
« From the Quick Access Toolbar click the New Email [ = icon. Email hems~ o Ju . _
. . E-mail Message Using »
* Using the keyboard (Ctrl+N) or (Ctrl+Shift+M). Mew

More [tems »
Sy Skype Meeting
The Mail Message Item
This is the main window where you create and compose the emails you wish to send.

Address Book:
Find and create contacts.

Quick Access Toolbar:
Add or remove your most
frequently used action button

To: Type the recipient’s
email address. (If the
recipient is in your

Backstage View:
Contains external
file commands.

Address Book the name The Ribbon:
and address will be ? = Confim nert months meefings - Message 07iML). B — O % When you create a New
auto-completed. You can Optons  FormatText  Review  Q Tell mewhat you want o do.. Outlook Item, the appropriate

> -

access the Address Book
by clicking the “To” button.)

Ribbon and tab options that
are required to compose a
message or task will appear.

| 2.5; [lj Attach File =
E == R it It
Address Check ceent ttems

Book Mames T GW-upgrade.png

Basic Texnt fa Names C:\Users\jamesb\Desktop',

Iza: Lunch-a-porter-door-graphic-3.pdf
4= C\Users\JamesB\Desktop',

Cc: Send a carbon Clipboard s
copy of this item to other ‘E\ o

Attach Files: Click the

Debbie Howlett {246) (Debbie. Howlett@netmail. cor

users. To sen‘d a I%Ilnd = . Luncapoter-door rptic 2o attachment_ icon, broyvse and
carbon copy “Bcc” to B, Z=] CUsers\jamesb\Desktop\ select the file, and click OK.
Other reczlplentsl SeIeCt Subject Confirm next months meetings ? tTJI;:;E:‘;‘:E‘[?;;QD;E\phi(‘Pdf YOU can also drag and drop
the “Options” tab, click v —— i files from your system folders
the Bcc icon & EBee | the e |72 o ks ~ into the Message Area.

Bec field will appear. Confirm next month’s meetings. Subject: Enter the email

(ReCipientS cannot see the It's going to be very busy over the next few weeks.| Subject
other Bcc reCIpIentS)' Let's get as much as we can done. m\ .

= Message Area: Type the
Send: Click = button to content of your message here.
send your message.

Thanks Rnh Rroun I

New to Outlook16: Save time by easily attaching

L—— documents that you most recently used to your emails on
the ribbon. Attach files from OneDrive or SharePoint, you
can share them as View only, or give Edit permissions.

The Ribbon

The Ribbon is designed to help you quickly find the commands that you need to complete tasks. Commands are organized
in logical groups, which are grouped together under tabs. Each tab relates to a type of activity, such as writing or laying out a
page. The Ribbon is part of the Microsoft Office Fluent user interface system and appears in a variety of Office products.

Right click the Ribbon to minimize.

Format Text Review Q Tell me what you want to do...

?; [* Follow Up~
= ]

! High Importance ¢

ach_Signature Office
¥ LowImportance  pdd-ins

Basic Text ra | Add-ins ~

Message Tab: Insert Tab: Options Tab: Format Text Tab: Review Tab:

Contains basic Outlook In this tab you can The options for formatting  Allows you to set font Review spelling and

commands, such as access all items that  your messages are found and paragraph styles, grammar, translate

cutting and pasting, can be inserted into  here. Choose themes, find and replace text, languages, consult

attachments, basic text ~ your messages like  text or HTML formats, zoom in and out and cut  dictionaries and

formatting, etc. images, shapes, page color, delivery and paste items to the encyclopedias.
tables, etc. instructions, etc. clipboard.

Note: The options available in the Ribbon will change according to the Outlook Item you are using. Page 2



Managing Received Messages

Outlook 2016 offers a number of features to improve message management. You may organize your email items with
color-coded categories, set rules, and file the messages in specific Cabinet folders.

Inbox: Stores received mail items.

Defeted Items 381

Sent ltems: Stores
copies of all sent items.

Contents of selected folders will
appear in the Message List.

Received Mail Message Item

4 Fayorites < Search Current Mailbox [... S | furrant Mailhne x|
By Copy
ML % All Unread By Date o,
s Quick Print
Sent Itemns A T
Reply
Drafty [3] ) £2 Reply
Pierre Chamberland @ Renh Al
Delethd ftems 381 got your vmail 2 Reply Al
thanks - we'll work on Q_) Forward
Aja les.bassett@netmail.com 4 Yesterday 3% Mark as Unread
Inbx 2 Debbie Howlett iin Ctegorize  »
Drafts [3] gfj;"'ﬁ::‘m”“”"“ [> Follow Up >
Serft rermns B EindRelated  »

Quick Steps »

| Capinet i PRules
Cgnversation History ¥ Move
_,m OneMote
% Ignore
."?\ Junk
7< Delete

Right-click an item to display the action menu.

Copy: Copies message and content to the clip board.

To paste a copied item, select the desired Folder and enter
(Ctrl+V) using the keyboard.

Quick Print: Prints the content of a selected item.
Reply: Sends a reply message to the sender.

Reply All: Sends a reply message to the sender and
all other recipients of the email.

Forward: Forwards the highlighted item to another recipient.
Mark as Unread: Marks the message as unread.

Categorize: Classifies the item in a specific category
and color-codes it.

Follow Up: Flag the item and schedule it in your calendar.

Find Related: Find related messages or messages
from the sender.

Quick Steps: Access your automated tasks.

Rules: Allows you to create specific management rules.

Move: Moves an item to a chosen folder.

OneNote: OneNote is a digital notebook for capturing, sharing,
and saving information.

Ignore: Keep unwanted conversations out of your Inbox.
Junk: Enables junk mail handling.

Delete: Moves the highlighted item to the Trash or deletes
the message from the system.

When you receive an email, it will be stored in your Inbox folder. After opening an email, you can read and manage it.

You can use the Ribbon to reply, forward,
delete, move to folders, create a rule,
block, categorize, and find related items.

Message: View the message in the
Reading Pane or double-click the item in
the Message List to open it in a seperate
window.

Attachments: Click the item to view it in

the message area. To open an attachment, —
double-click the icon, or right-click the
attachment and select the appropriate
action (open, save, move, delete, etc).

To close the email window: Click the
exit button in the upper right corner of the
window, type (Alt+F4), or use the (Esc) key

&~ Delete

Tl X 8 s German workshop - Message (HTML)
Message Developer Q@ Tell me what you want to do...
& x :,] rﬁ;‘,] ﬁ;} m ¥ Inbox Yoo - | 5% Mark Unread %} el q
€€ = £} To Manager B B Categorize - B-
Reply Reply Foward g, = A — Move —_ Translate Zoom
Al Team Email = . Div |® Follow Up~ - -
Rﬂpond qulckstegs ] Move T_ag_s ] Editing Zoom A

Delete

Debb
Debb

T1KE

Iz

Action ltems

Hi James,

on your keyboard.

Note: The options available in the Ribbon will change according to the Outlook Item you are using.

ie Howlett
German workshop
OYou replied to this message on 3/8/2016 8:12 PM.

Proforma Service Orde...

| got the text from Viktor and created the thank you page here: https://www.netmail.com/de/vielen-dank-f%C3%BCr-ihre-
anmeldung-zum-netmail-workshop

Here's the landing page: https://www.netmail.com/de/netmail-workshop-gwava-retain-archiv-migration
Can you replace the speaker image with something else relevant to the workshop? A logo maybe?
Also, if possible, can you add a “Add this to my Calendar” widget to the text at the very bottom of the page —

Nannarctan 14 NA 20418 11m 4AA-A0 | ke

James Bassett Tue 4:23 PM

+ Get more apps
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Address Book and Contacts
Use the Address Book to look up and select Contacts and Distribution Lists when you address messages.

Finding Names in Search People in the Ribbon

In the Ribbon, type the name of the contact that you want to find in the Search People |*=arch Peepl= | box (F11). Outlook will
search in Contacts. If no match is found, Outlook will then search all the available Address Books.

How to Open the Address Book

From the Home Tab in the Ribbon, click the Address Book [Z= icon. When sending a message, select the Message Tab,
click the Address Book [E= icon.

Using the Address Book:

1. In the Address Book list, Ll Address Book: Global Address List [= ][ @ |5
choose the address book you i
want to search. Search: @ Name only

(71 More columns

2. In the Search box, type the name, —Hr Go | | Global Address List - James.Bassett@netmetw|  Advanced Find
or part of a name (Outlook will auto- James.Bassett@netmail.com
| MName Title Contacts
complete the name), that you are lﬁ
H All Address Lists
searching for. o il Comtacts
3. |f you W|Sh to Send an ema” to the a Tvan Bilev Technic All Distribution Lists
& Jacgueline Towers Salesp;  All Groups
selected name, choose Menu bar > = James Bassett Medis | AllRooms
. AllU T
File > select New Message (Ctrl+N). & Jean-Marc Noiseux Networ  Public Folders -
& John Lee Sales Engineer (514} 3929220 =206 Canada i
@ Mame only Search by name on|y_ & Judi Kohn Knowledge Base Administr... (514) 392-9220 #267  Canada
4| 1 | 3

@ More columns Allows you to search
using other criteria like title or location.

Create and Manage Contacts
You can add new contacts to Outlook 2016 Contacts by typing the information directly in the contact form.

To Create a New Contact: ontactsRibon

1. Click People = inthe

= g s Untitled - Contact

Contact Insert Format Text Review 2 Tell me what you want to do...

Nawgatlon bar at the bottom of = x R SaeliNew - | | @ Emai 3 & | E I Categorize -
the W|ndOW. H [&5 Forward - '.'-'EMeeti ! J@ "ﬁ ™ Follow Up ~
. Save & Delete Show Address Check  Business Picture ) Zoom
2. In the Ribbon of the Contact Pane Close &, OneNote v J#Wore™ | Book Nemes Card - Private
CIICk New Contact El . Actions Communicate MNames Cptions Tags Zoom ~
c:::::{t Full Mame... s, Carla M Banks Ms. Carla M Banks

Netmail

. e - Metmail i
Open, Modify, and Add Contacts = e
. Job title HR Director (514) 3929220 Work
N the Address book: / . cb@netmail.com :
B . . File as Banks, Carla M - 180 Peel street, Suite 333
1. Click the Address Book icon in Intermet Monireal Quebec H3C 267
. anada
the Contacts Ribbon to open the Femai. |- | [c@nctmalcon wun.netmail.com
Address BOOK W|nd0W iplay as Carla M Banks [cb@netmail.com]) Note: TO Create a New
2.1n the Address BOOk I|St, Web page address www.netmail.com contact from anyWhere |n
choose the address book where IM address Outlook, Press Ctrl+Shift+C.
you want to add or modify a contact. Phone numbers |
i iness... - 514) 392.9220
3. Choc_)se the contact you W|s_h to Business Note: To save the contact
modify, or select, Menu > File > Business Fax.. | - | | (51413920100 information directly from
New Entry. Mobile... - an email, Right-click the
4. Enter the contact information. Addresses sender’s name and choose,
Business... - 180 Peel street, Suite 333

5. Click Save (Ctrl+S). %  Add to Outlook Contacts.

=

Mantreal Quebec H3Q26G7,
| This is the mailing | Canada

address Map It

Use the drop down menus / \
to choose which categories
you want to input. To modify the layout of the Business Map It: View a map of

Card, double-click in the card field and the contact’s address.
make the desired changes.

Note: The options available in the Ribbon will change according to the Outlook Item you are using. Page 4



Calendar and Scheduling

The Outlook Calendar lets you manage Appointments and Tasks. You can create multiple calendars and share calendars

Use the Navigation Arrows ¢ * November 27,2014 to display the next or previous dates.
Click a date to display the events for that day. Dates that appear in bold indicate scheduled activities.

Q Tell me what you want to do...

Calendar Ribbon

Calendar - James.Bassett@netmail.com...

Arrange Section: Lets you select
the calendar view you prefer: ————_|

Send / Receive Folder View

= Week + [l
Day, Week, Month. G H B &R
y, ’ EN&WMee‘cmg New 57 D E DE ﬁ £ Month UIJ C’\_"; Elj! B~  [EE Address Book
. _ ew Skyp ay or pen alendar -mail
D|Sp|ays calendars that you have E& Newltems - Meeting 7 Week (= schedule View Calendar ~ Groups~ Calendar &
Created OI' Ca|endaI’S you have MNew Skype Meeting Go To [F] Arrange & Manage Calendars Share Find ~
. ‘ March 2016 N Tod :
shared rights to. To manage the o e 4 March 2016 ¥ gegrapop [ Search Colendar cti-B »
Calendar folders, right-click in the B 8 1 2 3 4 5| SUN MON TUE WEDNESDAY  THURSDAY SATURDAY [+
My Calendars field and select the s1 s s w5 Mar 1 2 3 4 5
. . 13 14 15 16 17 18 19 . - . . -
11:30am Daily 11:30am Dail 11:30am Daily 11:30am Daily 11:30am Daily
deSIred aCtlon 20 M 22 33 M I35 X Mark:tr\nngaly Mark:tngaly Mark:tr\nngaly Mark:tr?ngaly Mark:tni.lngaw
i oo oD & StandlUp;_ StandlUp; StandlUp;_ StandlUp;_ StandlUp;
TO Create a new AppOIntment James® Offic... James’ Offic... James® Offic... James® Offic... James’ Offic...
)
Task or Note, double-click s
P20ty 6 7 8 9 10 12
the respective item area or SU MO TU WE TH FR SA 11:30am Daily [ 11:30am Daily | 11:30am Daily ] 11:30am Daily
. . 1 2 Marketing Marketing Marketing ... ‘ Marketing ...
select the appropriate action Stand Up; Stand Up; === o
James' Offic... James' Offic... L e .
in the Ribbon Invitation: F... M Meeting wi...
. . 14 15 16 17 18 19
To reschedule an |tem,.drag it to 11:30am Daily [/11:30am Daily [/11:30am Daily 11:30am Daily
the updated date and time (does gy | dMareing.| pMaeT | Flins0am Da..| [ aanc
not apply tO group appOIﬂtmentS James® Offic... - James® Offic... _ James’ Offic...
sent by another user). [/ My Calendars » 2 5 4 i 6
| Calendar 9:00am See ... || 11:30am Daily 11:30am Daily || 11:30am Daily
. . . r Marketing Marketing Marketing
To view an existing Calendar ) 1130am D2 gangup, Aoy StandUp  Stand Up,
. . " 4[| Team: Debbie... _ James' Offic... § James’ Offic... James' Offic...
Marketing ...
item, double-click it to open and = (i
view the details. 27 28 29 30 31 Aprl 2
11:30am Daily 11:30am Dail 11:30am Daily 11:30am Daily 11:30am Daily
Other Calendars I\-‘Iark:tr\nngaw Mark:tngal} Mark:tr\nngaw Mark:tr:.lngaw Mark:tTngaw
JStandl%p;;f_ Jitandlngf;f JSlandl%p;;i_ JStan\:Il%p;;f_ JStandIL(I:[iJf,‘f
= = 28 ees ames’ Offic.., ames’ Offic.., ames’ Offic.., ames’ Offic... ames’ Offic..,
Items: 34 All folders are up to date. Connected to: Microsoft Exchange [D @

Schedule an Appointment:
1. Click the New Appointment icon

El in the Calendar Ribbon
(CtrI+N).
Mew

Appointment

Note: If there is a conflict when scheduling appointments or

meetings, Outlook will automatically notify you. You can also
select the Scheduling icon in the Appointment Ribbon and
check the recipient(s) calendar(s) for conflicts.

|Appointment Ribbon

Email policy workshop - Appointment

2. Type a SubjeCt fOl' yOUI’ Format Text Review Q Tell me what you want to do...
appointment in the Subject field. @ x = o8 = @ ol [ p ’
. ) o e b o
3' Enter the meetlng |Oca’[I0n Save & Delete = . £S5 Schdduling Assistant Invite Skype Meeting Options  Tags  Office
in the Location field. Close 2 Attendees Meeting~  Notes < * Add-ins
- Actions Show Attendees Meeting Motes Add-ins M
4. Enter the Start Time
and End Time 6Thisappointmentconflict another one on your calendar.
. Subject ksh
5. Type an optional message e hlies
or add attachments for Location Conference room 2 -
the appointment time Mon 3/21/2016 [E| 1130 AM - All day event
’ / Endtime | Thu3/24/2016 [E| |12:00 PM -
6. Click Invite Attendees in the
- - L 1
Appointment Ribbon and stacheg | (¥ MAPresentatonppec
choose which people or groups
you would like to invite. If you miss the appointment.
7. Click Send.

Note: The options available in the Ribbon will change according to the Outlook Item you are using.
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Sharing Contacts and Calendars
Outlook lets you share your contacts and calendars with people inside or outside your organization*.

* To share with someone outside your organization they must have an Exchange or Office 365 server.

To Share your Calendar:

. . . . H < » Sharing... ? = = o
1. Click Calendar g in the Navigation bar at the bottom
of the window. File Share Insert Options Format Text Review
2. In the Ribbon of the Calendar Pane, Click Share Calendar ShD’
Calendar T ¥ dh@netmail. com;
3. Type the name of the person or email address you want ——— | Subject Sharing invitation: James Bassett - Calendar

to share your Calendar with in the To box. send

4. In Details specify the level of details you want to share. Allow recipient to view your Calendar

5. Click Send. I
etal Full details .

| Request permission to view recipient’s Calendar

Includes the availability and full
details of calendar items

Note: To modify the Properties for Calendar or
Contact sharing, right-click the desired folder in the
Navigation Pane and choose Properties, then select

. James Bassett - Calendar
the Tab you want to modify. E

Microsoft Exchange Calendar

Type your notes here. -
H % » shai. O
File Share Insert Options Format Text Review
To Share a Contact:
oo I dhEnetmail,com; 1. Click People = in the Navigation bar at the bottom
3 of the window.
cong | TiTect  [Neringrequest People 2. In the Ribbon of the People Pane, Click Share Contacts ;D’
Request permission to view recipient's Contacts folder b
| Allow recipient tewisw your Contacts folder ~~ 3. Type the name of the person or email address you wish to
\ share your Contacts with in the To box.
L?_%J ﬁ:rii:s:fha:::i':ma e 4. Click to specify the level of permissions you want to share.
- 5. Click Send.
Type your message here. -
Keyboard Shortcuts
Table of common keyboard shortcuts that will help you navigate and work more efficiently.
fBasic Navigation 1 Create a Folder CTRL+SHIFT+E Reply All to a Message CTRL+SHIFT+R
Switch to Mail CTRL+1 Create a Journal Entry CTRL+SHIFT+J Forward a Message CTRL+F
Switch to Calendar CTRL+2 Create a Meeting Request CTRL+SHIFT+Q Save CTRL+S
Switch to Contacts CTRL+3 Create a Note CTRL+SHIFT+N Save and Close ALT+S
Switch to Tasks CTRL+4 Create a New Office Document CTRL+SHIFT+H Save As F12
Switch to Notes CTRL+5 Post to This Folder CTRL+SHIFT+S Undo CTRL+Z
Switch to Folder List CTRL+6 Post a Reply in This Folder CTRL+T Delete an ltem CTRL+D
Create a Search Folder CTRL+SHIFT+P Print CTRL+P
(Quickly Create Items 1 Create a Task CTRL+SHIFT+K Copy an Item CTRL+SHIFT+Y
Create a Message CTRL+SHIFT+M Create a Task Request CTRL+SHIFT+U Move an Item CTRL+SHIFT+V
Create an Appointment CTRL+SHIFT+A Check Names CTRL+K
Create a Contact CTRL+SHIFT+C (Common Actions 1 Check Spelling F7
Create a Distribution List CTRL+SHIFT+L Open a Received Message CTRL+O Flag for Follow Up CTRL+SHIFT+G
Create a Fax CTRL+SHIFT+X Reply to a Message CTRL+R Send or Post or Invite All ALT+S
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